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This paper presents uses for the Open Database Connectivity (ODBC) interface and the 
application of Internet Database Connector or Active Server Pages.  Software is suggested that 
provide for seamless integration between the Web server, database connector, and database 
application.  The described processes and examples provide, at best, the basic information and 
structure necessary for the creation of an ASP student resume page.  It is intended to assist Web-
site developers in achieving a minimal no frill Web site for a construction program’s students to 
be able to post their resumes on the Internet. 
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Introduction 
 
Building a useful Active Server Page (ASP) for an institution's Internet web site is well within 
the reach of most web-site developers.  It should be noted that this paper is written on a level 
where the reader should have some prior experience with writing Web pages and a cursory 
understanding network servers.  With Web browsers appearing on most all user (Web client) 
desktops and Web servers providing standard Structured Query Language (SQL) gateways, 
many valuable program, faculty, and student databases are just waiting to provide manageable 
and user friendly information over the Internet. 
 
Users with Local Area Network (LAN) access can quickly connect to a Microsoft Access® 
database using Web client software in the form of a Web browser, such as Netscape Navigator® 
or Microsoft Internet Explorer®.  All one needs to develop such an ASP is a Web server, a 
database connector, and a database.  Using service software such as Microsoft NT®, Microsoft 
Internet Information Server® (IIS) and Microsoft Office Suite Professional® makes the ASP 
process even easier because of the built-in Open Database Connectivity (ODBC) interface and 
seamless integration between application software.  Additionally, the Microsoft FrontPage® 
software package will easily and effectively integrate the Web site’s administration, page 
authoring, and photo/graphic editing tasks (see Appendix A for suggested software). 
 
For a typical Web page, the Universal Resource Locator (URL) fetches a static Hypertext 
Markup Language (HTML) file within the directory structure of the Web site and returns this file 
back to the Web client as pre-formatted HTML page.  For an ASP, the URL points instead to an 
Internet Database Connector (IDC) file that executes a program or script that executes a query 
fetching the contents of Fields within a database.  The Web server then dynamically formats the 
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results in HTML and sends this HTML page back to the Web client.  Because this process is 
based on the Internet, the Web client platform can be any machine that runs a Web browser, and 
the Web server platform can be any machine that runs a Web server. 
 
The Associated Schools of Construction's Web site running on Windows NT® uses the ODBC 
abilities of IIS to serve and implement many different ASPs using a Microsoft Access® database.  
Examples of these ASP can be viewed on the ASC's Web site; http://ascweb.org, i.e., the 
membership directory, its related update pages and the reviewer listing within the Journal of 
Construction Education. 
 
The design of this paper is to familiarize a web-site developer with the database connectivity 
capabilities of a Web server.  This paper first provides the web-site developer with the 
procedural algorithms required for ASP design and then demonstrates how to publish student 
resumes on their Web site.  Also provided are sample Web-site directory folders, HTML (HTM), 
executable HTML (HTX), and IDC, files for the developer's unrestricted use, including their 
being imported into an institution’s Web-site.  This WinZip file (Resume Page Download.zip) is 
accessible at ftp://ascweb.org/resume and is available for downloading as an attachment to this 
paper. 
 
 

Active Server Pages 
 
The function of any Web server is to serve HTML files.  Using ASPs, pages with new dynamic 
content can be created in response to Web client requests.  The Web server itself becomes active 
in the process of creating the Web page.  It is important to understand how this process is carried 
out (Figure 1). 
 

1. The Web client enters the URL address of a Web server with an HTM extension into the 
address bar of a Web browser and presses Enter.  The Web client is then served a static 
HTML Page from Web server. 

2. The Web client picks a hyperlinked button or text on the page, which is linked to a URL 
address of an ASP file with an IDC extension. 

3. The Web browser sends a request for the ASP's IDC to IIS. 
4. IIS receives the request and recognizes the IDC extension as a program and retrieves the 

IDC file from the directory structure of the Web site. 
5. IIS processes the IDC's SQL string from top to bottom.  The SQL string identifies the 

Access database MDB file where data is maintained, retrieves the information requested 
from the database Fields, and executes an HTX template file. 

6. The HTX template file writes the HTM file and sends the results of this process back to 
IIS. 

7. IIS sends the HTM file back to the Web browser. 
8. The Web browser interprets the HTM file and displays the results as a static HTML page 

for the Web client. 
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Building any ASP application requires five basic steps: 
 

1. Create a database for the ODBC and IDC to access in a Web site's directory that is hidden 
(i.e., _private directory, see Figure 2). 

2. Configure the IIS for ODBC and establish the database interface. 
3. Create HTM pages to start the query by put a URL address pointing to the IDC in an 

HTM file somewhere accessible for reading by a Web browser (almost anywhere under 
the Web site's directory, see Figure 2). 

4. Create IDC file to translate SQL string into HTML, and putting the IDC file into a Web 
server directory that is enabled for execution (i.e., _exec or _cgi-bin directory, see Figure 
2). 

5. Create HTX template files that the IDC will use to translate the SQL string results into 
HTML, and putting the HTX files in the place indicated in the IDC files (same directory 
as the IDC files). 

 
 

 
Figure 1.  ASP process. 
 

 
Figure 2.  Web site directory structure. 
 
 

The Student Resume ASP 
 
The remainder of this paper references the Student Resume Web-site pages accessible at 
ftp://ascweb.org/resume.  Download the WinZip file and unzip it to the desktop.  Open 
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FrontPage Explorer® and import the directories and files into the root web directories of the Web 
server.  Appendix B contains a complete listing of file setup procedures and Appendix C 
contains a complete listing of directories and files. 
 

Setting Up Your Database 
 
The Microsoft® Access database (stures.mdb) used in this example is stored in the "_private" 
directory of the downloaded Web site.  To make the data accessible, it must be stored in a table.  
The table included within the “stures.mdb” is named “students.”  After importing the database 
onto the Web server, it can fill it with information.  In this example, the database can be 
populated with information attained from the student enrollment information supplied by 
university admissions office.  Only juniors and seniors should be included, thus making the life 
span of student resumes limited to two years.  The single asterisk Fields in Appendix D may be 
inserted and the double asterisk Field should be set up as a "Default Value" of "No".  The 
developer may create these Field columns in Excel and paste them into the database versus 
individual entry.  Do not forget to save the database in the _exec folder of the Web site when 
finished. 
 

 
Figure 3.  Resumes.htm 
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Figure 4.  Resume.htx 
 

Resume Page Web-site Pages 
 
Upon opening the Web site to the “resumes.htm” page containing the hyperlinked ASP 
selections for student resumes two sets of options are offered (Figure 3). The first set is arranged 
by graduating term and resume selection by alphabetized student name categories.  When a 
service selection is made and, for example, the “December 1998: A through F" hyperlinked text 
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is clicked, an SQL string runs from the "dec98_1.idc."  This SQL string captures the appropriate 
information from the data Fields within the “stures.mbd’ database, and by using the "resume.htx" 
template file the December 1998 undergraduate resumes, A through F, are posted within the Web 
pages target frame (Figure 4). 
 
The second service selection set is for students to enter, edit and review their personal resume 
data.  When a student selects the “Student Resume Update Page” hyperlink, the “sturesupd.htm” 
page containing the hypertext service selections by alphabetized student name categories are 
offered.  When a service selection is made and, for example, the student’s last name begins with 
the letter “M” therefore, the “M through R" hyperlinked text is clicked, an SQL query runs from 
the "M_R_studentlist.idc."  This SQL query captures all the student names whose last name 
begins with the letters “M through R” from the data Fields within the “stures.mbd’ database, and 
by using the "M_R_students.htx" template file, builds and posts a listing within the Web page’s 
target frame.  If the student’s name is within that list, they proceed by entering their last name 
and the last five digits of their student ID number into the provided text boxes and selecting the 
"Update Resume" button.  If their name does not appear in the name list, they have not been 
populated within the student resume database and will have to be entered before they may 
continue.  This button executes the “M_R_student.idc” file, which runs the SQL query that 
captures that specific student’s resume information within the “stures.mbd’ database, and by 
using the "M_R_studentupd.htx" template file builds and posts the appropriate resume 
information for editing.  After editing and reviewing, the student picks the “submit Information” 
button that runs the SQL query within the “M_R_studentupd.idc” file.  This SQL query 
populates the student resume database Fields with the data and submits a hidden Field value 
which allows the resume to be built upon request from the first set of service selections as 
described above.  Additionally, this IDC file offers the “return.htm” page within the Web’s target 
frame, which confirms data entry and provides a hyperlink back to the “resume.htm” page 
(Figure 5). 
 
 

Conclusion 
 
This paper and example provides, at best, the basic information and structure necessary for the 
creation of an ASP student resume page.  It is intended to assist Web-site developers in 
achieving a minimal no frill site for a construction program’s students to be able to post their 
resumes on the Internet.  There are additional uses for this type of Web-site programming.  
Others could include student job postings, industry information pages, links pages, student 
surveys, and test administration.  You are welcome to browse the TAMU Construction Science 
Department’s, Dr. Williamson’s or the ASC’s Web site at: http://taz.tamu.edu/cosc, 
http://165.91.199.100/kcwilli, and http://ascweb.org.  Each of these sites provides active server 
page examples demonstrating the potential applications that can be developed within an 
institution's Web site. 
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Figure 5.  Student Resume Web Site Logic Diagram 
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Appendix A 
Suggested Software 

 
 

• Microsoft NT® 
• Microsoft Internet Information Server® 
• Microsoft Office Suite Professional® 
• Microsoft FrontPage® 

 
 
 

Appendix B 
File Setup Procedures 

 
 
Setting Up an ODBC System Data Source Name (DSN) 
 
To set up the ODBC DSN: 
 

1. Click the Start menu, point to Settings, and click Control Panel. 
2. In the Control Panel window, double-click the 32-Bit ODBC icon. 
3. In the Data Sources dialog box, click System DSN. 
4. In the System Data Sources dialog box, click Add. 
5. Select the Microsoft Access Driver and click OK. 
6. In the ODBC Microsoft Access 7.0 Setup dialog box, under Database, click Select. 
7. Locate the stures.mdb file in the _private directory on your hard disk, select it, and then click OK. 
8. In the ODBC Microsoft Access Setup dialog box, in the Data Source Name box, type Student Resume 

Database, and click OK. 
9. Click Close, and then click OK. 

 
 
Creating an HTML Extension (IDC) File 
 
Creating the IDC File: 
 

1. In the FrontPage Editor, on the File menu, click New, and select Database Connector Wizard. 
2. In the ODBC data source box, type stures, and then click Browse. 
3. Locate the resume.htx file, select it, and then click OK. 
4. Click Next. 
5. In the SQL box, type the following SQL statement: 

SELECT EntryID, StudentID, (Appendix E) 
6. Click Finish. 
7. Double-click the _exec folder.  In the Save As box, type dec98_1.idc and click OK. 

 
 
Creating an HTML Extension (HTX) File 
 
To create the HTX file: 
 
In the FrontPage Editor, create a New page, and enter the necessary text and column values to create the Resume 
page (see the resume.htx file provided).  Below is a simplified example of how to create a portion of this page. 
 

1. Create a table with two columns labeled First Name and Last Name. 
2. Select the second row in the table. 
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3. On the Edit menu, point to Database, and click Detail Section.  The detail section will be shown with 
brackets surrounding it, as in the following example: 

a. On the Edit menu, point to Database, and click Database Column Value. 
b. In the Database column name box, type FirstName, and click OK.  The database field name will 

appear in the table cell. 
c. Repeat step 6 for the Last Name column (this time type LastName in the Database column name 

box). 
4. Save the file and name it resume.htx. 

 
Note: The .htx and .idc files must be saved in the in the same _exec directory. 
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Appendix C 
Contents of Resume Page Download.zip 
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Appendix D 
Microsoft Access Database Fields 

 
 

Field Name Data Type Input Mask Required Allow Zero 
Length Indexed 

StudentID* Text 000\-00\-0000;0;_ No No Yes (Duplicates OK) 
Password* Text  No No No 
FirstName* Text  No No No 
MiddleInitial* Text ?.;0;_ No Yes No 
LastName* Text  No No No 
Suffix* Text  No Yes No 
NameSortID* Text  No No Yes (Duplicates OK) 
Approval** Text  No No No 
Zip1 Text 00000\-9999 No No No 
Phone1 Text 000.000.0000;0;_ No Yes No 
Zip2 Text 00000\-9999 No Yes No 
Phone2 Text 000.000.0000;0;_ No Yes No 
 
 
 
 

Appendix E 
Sample SQL Statement 

 
 
mySQL= “SELECT EntryID, StudentID, Password, Approval, NameSortID, FirstName, MiddleInitial, LastName, 
Suffix, Classification, GradDate, Address1, City1, State1, Zip1, Phone1, Address2, City2, State2, Zip2, Phone2, 
Email, URL, Institution1, CityState1, Degree1, Date1, Institution2, CityState2, Degree2, Date2, Institution3, 
CityState3, Degree3, Date3, Employer1, EmploymentDates1, JobDescription1, Employer2, EmploymentDates2, 
JobDescription2, Employer3, EmploymentDates3, JobDescription3, StudentOrganizations, Honors, SpecialSkills “ 
mySQL=mySQL &”FROM students “ 
mySQL=mySQL &”WHERE (GradDate='December 1998') AND (Approval='Yes') AND (NameSortID='1') ” 
mySQL=mySQL &”ORDER BY students.LastName” 
 


